Tutorial 3D AutoCAD 2000 - Planimetria Asistida

TUTORIAL DE 3D - CREACION DE UNA PIEZA MEDIANTE SOLIDOS.

Mediante este tutorial se intentara ver el proceso de creacion de una pieza mecdnica en tres
dimensiones de una manera detallada.

El camino a seguir ha intentado ser el adecuado para ver el maximo de herramientas disponibles en
AutoCAD 2000, si bien seguro que existen otras formas de hacer lo mismo, he elegido éstas.

Para empezar veamos céomo es la pieza que vamos a crear. Una primera perspectiva en tres
dimensiones nos da una idea de lo que queremos conseguir.
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En primer lugar vamos a hacer la figura que nos servira de perfil para la parte central del objeto.
Esta es:

Para esta explicacion en la barra de estado tienes que tener activada la referencia, el rastreo y el
rastreo polar, o sea, activar los botones [OSNAP], [OTRACK], [POLAR)].

Vamos a dibujar la primera linea.
7/ Line

Specify first point: con el puntero hacemos clic en cualquier lugar
de la pantalla.

Specify next point or [Undo]: Nos situamos sobre la horizontal y, il
mediante el rastreo polar hacemos una horizontal de longitud 32
escribiendo sencillamente 32 cuando veamos esta situacion.

Ahora los dos circulos.

Esta es una buena ocasién para usar las referencias por rastreo, y olvidarnos de las lineas
auxiliares o desplazamientos inutiles.

@ Circle (de radio 36)

El centro lo situamos acercandonos sin hacer clic al punto final derecho de la linea hasta activar la
referencia temporal de punto final (se tiene que ver una pequena cruz sobre el punto final). Nos
movemos por la vertical y escribimos 36, que es la distancia dénde
se situara el centro. La situacion es algo asi.

Situamos luego el punto extremo del radio en el punto final de
la linea y hacemos clic. Tenemos la primera circunferencia
dibujada.

Endpoint: 28.4895 < 2

Ejercicio: Intenta hacer la otra de radio 44 de la misma
manera.

Nos queda:
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Aqui tenemos los dos circulos con la linea superior. Vamos a hacer la
linea inferior, que es tangente a los dos circulos.

7/ Line

Specify first point: SHIFT + botén derecho, referencia Tangent. Nos acercamos a uno de los circulos
por la parte inferior.

Specify next point or [Undo]: SHIFT + botén derecho, referencia Tangent. Nos acercamos al otro
circulo por la parte inferior correspondiente.

Tenemos:

Ahora vamos a recortar lo sobrante.
7 Trim
Select cutting edges ...

Select objects or <select all> Seleccionamos las dos rectas. [BARRA ESPACIADORA o ENTER]

Vamos a crear una polilinea de este conjunto. Para eso vamos a la opcién Modify > Polyline.

Nota: En AutoCAD 2008 esta opcion se encuentra en el menti Modify > Object > Polyline.

Nos pide:
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Select polyline or [Multiple] Seleccionamos una de las lineas.
Luego el comando nos dice:
Object selected is not a polyline

Aunque no lo sea, seleccionamos cualquiera de las lineas de nuestro perfil. Nos pide si queremos
transformarla en polilinea. Respondemos, claro esta, afirmativamente.

Do you want to turn it into one? <Y>: y

Enter an option [Close / Join / Width / Edit vertex/ Fit / Spline /Decurve / Ltype gen / Undo]:
Seleccionamos la opcién Join escribiendo la letra .

Select objects: Designamos los demas tramos que queremos adherir al inicial.
Nos informa

3 segments added to polyline

Eso quiere decir que ya estamos. Para salir de la orden sencillamente apretamos a la tecla [BARRA
ESPACIADORA] o [ENTER)].

Para asegurarte selecciona la figura en pantalla. Si es uno solo objeto, ya es una polilinea.

Vamos a hacer una copia equidistante del perfil que luego utilizaremos.

& | Offset
Specify offset distance or [Through / Erase / Layer] <Through>: Escribimos 12
Select object to offset or [Exit / Undo] <Exit>: Seleccionamos el perfil.

Specify point on side to offset or [Exit/Multiple/ Undo] <Exit>: seleccionamos un punto
INTERIOR del perfil para crear una copia equidistante “hacia adentro”.

Realizamos la misma operacién de nuevo pero con una distancia de 2,4 hacia el interior. Tiene que
quedar:
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Crearemos por comodidad una nueva capa llamada AUX donde colocaremos la polilinea mas
exterior e interior. Desactivaremos ésta capa frezando la misma (hacer clic en el sol del cuadro de
control de capas) y asi s6lo tendremos la polilinea intermedia en pantalla.

Bien, ahora vamos al 3D.

Lo primero sera cambiar el punto de vista mediante la opcion View -> 3D View -> SW Isometric.

Mediante el botén derecho sobre la zona de las barras de herramientas activamos las barras de
Solid (ACAD 2000) o Modeling (ACAD 2007 en adelante) y Solid Editing.

Vamos a crear el cuerpo principal. Para hacerlo, haremos una extrusion del perfil que tenemos en
pantalla.

O Extrude
Select objects to extrude: Designamos el perfil [ENTER]
Specify height of extrusion or [Path] <0>: 56

Specify angle of taper for extrusion <0>: 3

Nota: En la versién 2008, en el comando EXTRUDE, previamente se debe configurar el angulo de
inclinacién antes de especificar la altura de extrusién. La orden quedaria:

Command: EXTRUDE

Current wire frame density: ISOLINES=41 found

Specify height of extrusion or [Direction/Path/Taper angle] <0>: t
Specify angle of taper for extrusion <0>: 3

Specify height of extrusion or [Direction/Path/Taper angle] <0>: 56

A partir de ahora debemos acostumbrarnos a trabajar con dos herramientas:

2 8D Orbit: Para orientar o cambiar el punto de vista del objeto segin nos convenga.

Visual Styles X |

{f . . . . . .
4999 Visual Styles o menu View > Visual Styles: Para cambiar el tipo de
visualizacién de la pieza entre sombreado, lineas ocultas, estructura de alambre, etc.

Por lo tanto, girando la pieza con la érbita 3D y sombreandola
obtenemos la siguiente figura, que nos da una idea del objeto que
hemos creado.

Este es el cuerpo principal de la pieza. Vamos a seguir trabajandola.
Primero recuperaremos el perfil que nos sirvié para crear el cuerpo.
Podiamos haber cambiado el valor de la variable DELOB< a 0 para
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que el perfil se conserve, pero, como no lo hemos hecho lo haremos con una opcién muy util que
conviene explicar.

i@ Copy edge

En la barra Solid editing encontramos esta opcién que nos permite recuperar aristas de un sélido
para crear lineas o curvas.

Select edges or [Undo/Remove]: designamos las aristas que formaron parte del perfil original y
luego [ENTER]

Specify a base point or displacement: Elegimos un punto cualquiera de la pantalla.

Specify a second point of displacement: Colocamos distancia igual a cero (0). Esto implica que el
primer punto y el segundo son los mismos.

Obtenemos un perfil como:

Ahora activamos la capa AUX donde teniamos los perfiles (desde el ment desplegable de las capas
hacemos clic en el “sol”).

Seleccionamos los perfiles y los ponemos todos en la capa, por ejemplo, 0 (la original).

O Extrude
Select objects to extrude: Designamos el perfil mas exterior [ENTER]
Specify height of extrusion or [Path] <0>: 8
Specify angle of taper for extrusion <0>: 0

Obtenemos: e ———

Nota: Hasta ahora el sistema de coordenadas UCS no lo hemos variado. Recordar que la extrusion es
sobre el eje Z.

@ Union: Utilizaremos la operacién booleana para unir los dos sélidos en uno. Para ello sélo tienes
que seleccionarlos. Cuidado no selecciones los perfiles, solo los s6lidos.

Vamos a hacer la hendidura en el sélido. Para eso utilizaremos las operaciones de estampar y
extruir caras, dos herramientas nuevas y muy potentes.
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& Imprint

Con esta opcién proyectaremos sobre el sélido los dos perfiles que nos quedan para crear una nueva
cara que podremos modificar.

Select a 3D sollid: Seleccionamos el sdlido ya unido (no hay que apretar [ENTERY]).
Select an object to imprint:
Delete the source object [Yes/No] <N>:y
Uno a uno vamos seleccionando los perfiles y suprimiendo el original.
Extrude faces

Select faces or [Undo/Remove]: Vemos como seleccionamos la cara que
se ha creado entre los dos antiguos perfiles. Apretamos [ENTER].

Specify height of extrusion or [Path]: -2.4

El signo negativo indica el sentido de la extrusién, o, visto desde otro
punto de vista, que estamos quitando material.

Specify angle of taper for extrusion <0>: 0

Veamos el resultado... Ya empieza a tener forma, no?

Con la herramienta de Orbita 3D giramos la pieza para poder verla tal
como aparece en la figura.

Vamos a hacer la parte trasera.

Primero necesitamos colocar el UCS de manera adecuada.

s UCS Face Alineamos el sistema de coordenadas con la cara del

fondo.

\
Select face of solid object: Seleccionamos la dicha cara tal como vemos l:’ + ’,‘
en la figura N /
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El resultado se puede ver en la figura. Notar que en este caso esta activa la
opcién de Icono de UCS en Origen presente en la Ventana de Propiedades.
Tenemos orientado el eje Z perpendicular a la cara y el plano XY esta situado en la
misma, tal como deseamos.

Vamos a dibujar este perfil en la cara trasera.

30,72

Los dos circulos estan centrados en los otros dos de
la cara trasera de la pieza.

@ Circle (de radio 24)

Situamos el centro del circulo mayor de la cara trasera e introducimos un radio de 24. Fijate en la

figura.

Veamos como situamos el centro del circulo.

4

Dibujamos el circulo de radio 24 y nos
queda ...

De la misma manera creamos el circulo de radio 12.

Ejercicio: De forma andloga a como hicimos al principio con el primer perfil, dibuja las dos lineas de
tangente a tangente a los dos circulos.

Tiene que quedar

Ejercicio: Recorta la parte sobrante de los circulos como hicimos al principio.
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[ Region

Si recordamos, para preparar el perfil inicial que luego ibamos a realizarle una extrusidn,
primeramente lo convertimos al conjunto en una polilinea. Ahora utilizaremos otro método, y es
convertir el perfil en region.
Select objects: Designamos los cuatro tramos con cuidado de no seleccionar el sélido y luego [ENTER].

El comando nos indica 1 loop extracted y 1 region created.

Ya tenemos una regién que podemos extruir.

O Extrude
Select objects to extrude: Designamos la region y [ENTER]
Specify height of extrusion or [Path] <0>: 4
Specify angle of taper for extrusion <0>:

Como no hemos variado el UCS, el eje Z esta situado de forma perpendicular a la cara, como
queremos para formar este soélido.

.Y el resultado? Pues algo asi:

@ Circle (de radio 24)

Situamos el centro en el centro del circulo mayor de la nueva cara trasera e introducimos un radio de
24 o mediante la referencia de cuadrante, como se prefiera. La

cuestidn es crear un nuevo circulo tal como...

Ejercicio: Extrusiona el nuevo circulo con una altura de 4 y un angulo de 0, para obtener...
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Bien, pues solo nos falta unir las tres partes con la misma opcién de

antes, la operacién booleana Union @

Selecciona los tres s6lidos y ya esta. Sombréalo y mira el resultado.

Ahora vamos a hacer el cuerpo superior. En este caso es un poco més complicado situarnos en el
lugar adecuado.

Utilizaremos el método clasico de “primero me posiciono y luego dibujo”.

Primero vamos a situar el sistema de coordenadas donde necesitamos. Veremos asi otras
posibilidades en las herramientas del UCS.

Vamos a situar la pieza tal como indica la figura mediante el 3D Orbit.

Hacemos un Zoom window sobre la parte indicada por el recuadro.

Vamos a crear un sistema de coordenadas indicando su origen y
posicién de los ejes.

3 . . . . .
L uces 3 points: el primer punto determina el origen de coordenadas, el segundo el eje X y el
tercero el eje Y. Los tres puntos que indicaremos seran los puntos finales de las rectas representadas

en la figura.

\

Ori

Tenemos una primera situacion del sistema de coordenadas. Pero vamos a desplazarlo.
UCS Move: Mediante esta opcién desplazamos el punto de origen del eje de coordenadas.
Specify new origin point or [Zdepth] <0,0,0>: @16,6.4,2.4

El nuevo punto de origen respecto al actual estard a 16 U.D. enel eje X, 6.4 U.D.eneleje Yy 2.4 en
el eje Z. Recuerda utilizar la @ para referirte al iltimo punto, en este caso, el “antiguo” origen.
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Posicion del nuevo UCS

Desplazamiento
en Yde 6.4

Desplazamiento en X de 16

Desplazamiento en Z de 2.4

Vamos a dibujar el recuadro que nos servira de perfil para el nuevo sélido.

~ Polyline
En este caso dibujaremos directamente una polilinea. Recuerda tener activa la opcién [ORTHO].
Specify start point: 0, 0, 0
Luego desplazamos el mouse en el sentido del eje X positivo.
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: Escribimos 16 y [ENTER]
Después desplazamos el mouse hacia “atras” en el sentido del eje Y positivo.
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 32
Nuevamente desplazamos el mouse en sentido del eje X, pero con sentido negativo
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 32
Ahora “bajamos” el mouse en sentido negativo del eje Y
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 32
Finalmente utilizamos la opcién Close del comando.

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: c

(" Fillet
Haremos un empalme o redondeo de los vértices en la polilinea.
Select first object or [Undo/Polyline/Radius/Trim/Multiple]: r

Specify fillet radius <10.0000>: 2
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Ponemos el radio de empalme a 2, por si no lo estaba.
Volvemos a ingresar al comando.
Current settings: Mode = TRIM, Radius = 2.0000
Select first object or [Undo/Polyline/Radius/Trim/Multiple]: p
Le indicamos que empalmaremos una polilinea.
Select 2D polyline: Designamos el cuadrado.
4 lines were filleted
1 was parallel
Ya esta. El resultado, desde una vista superior.

Vamos a extrusionarlo.

9 Extrude
Select objects to extrude: Designamos la polilinea y [ENTER]
Specify height of extrusion or [Path] <0>: -18
Specify angle of taper for extrusion <0>:

La altura es negativa porque si no hemos cambiado el UCS, el sentido del eje Z es contrario al que
queremos para la extrusion.

@ Union Unimos los dos sélidos para formar uno solo.

La figura esta casi completada. Faltan los agujeros y redondeos. Esto me lleva a daros dos reglas
basicas del modelado:

1. Los agujeros lo mas al final posible.
2. Los empalmes o chaflanes lo mas al final posible.

Veamos como va quedando el sélido. Damos pues un par de vueltas con la érbita 3D.
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Vamos pues a seguir las reglas y hacer los agujeros.

Empezaremos por los dos principales que forman el siguiente
perfil.

Ejercicio: Inténtalo td. Debes situar el UCS adecuado para
poner el plano XY en la cara del perfil. Luego dibujar los dos
circulos (sus centros estan en los centros de los circulos exteriores).
Luego recorta la parte sobrante y convierte el perfil en regidn.

Cuando acabes, sitia el UCS en la posicion World 12 para
continuar.

0 Extrude

Select objects to extrude: Designamos la region y [ENTER]
Specify height of extrusion or [Path] <0>: 48
Specify angle of taper for extrusion <0>: 3

Una vez creado el sélido que nos servira para hacer el agujero, solo necesitamos hacer la operacién
booleana de Subtract.

© Subtract

Select solids and regions to subtract from... Seleccionamos el sélido principal + [ENTER].

Select solids and regions to subtract... Seleccionamos el sblido que nos servira para crear el
agujero.

Ya tenemos el primer agujero.

Giramos la pieza con el 8D Orbit, situamos el UCS en la cara circular
posterior y dibujamos un circulo de radio 16 sobre ésta, para
conseguir...
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Luego extrusionamos el circulo con altura 16 (cuidado con el signo) y angulo de inclinaciéon 0 para
luego generar el agujero con el comando Subtract.

Ya que estamos situados detras, vamos a hacer los otros cuatro
agujeros.

Situa de nuevo el plano XY en la cara adecuada y dibuja un circulo de
radio 2.4 a una distancia del centro del agujero de 20, tal como se
muestra en la figura. Lo mas importante en este caso es situar bien los |
ejes. Podemos utilizar el rastreo polar para situar el centro del circulo. . A

Luego extrusiona el perfil con una altura de 8. =

Antes de hacer la diferencia para crear el agujero haremos una copia matricial para utilizar ese
cilindro también para los otros tres. Con el plano XY aun situado en la cara trasera utilizamos...

aa Array
Select object: Seleccionamos el cilindro y [ENTER]
Select object: Enter the type of array [Rectangular/Polar] <R>: p (en nuestro caso sera polar)
Specify center point of array: Mediante la referencia centro seleccionamos el centro del agujero.
Enter the number of items in the array: 4 (3 + el propio)

Specify the angle to fill (+ = ccw [sentido contrario a las agujas del reloj], - = cw [en el
sentido de las agujas del reloj]) <360>: 360

Rotate arrayed objects? [Yes/No] <Y>: En este caso es indiferente.

© Subtract

Select solids and regions to subtract from... Seleccionamos el sélido
principal + [ENTER].

Select solids and regions to subtract... Seleccionamos los cuatro
cilindros.
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Agujerearemos la tapa superior de la pieza. Para eso hay que situarse de

manera adecuada. Muévete con el 3D Orbit y sitia el UCS en la cara -
correspondiente.
P
RLE _~ )
Ejercicio: dibuja en la cara estos circulos. Extrusiona el circulo mayor con
una altura de 38 (dngulo 0) y resta el cilindro resultante al sélido principal. £,

Extrusiona los otros cuatro de radio 1.6 con una altura de 4 (dngulo 0) y -
réstalos de igual manera.

| Chamfer
Haremos un chaflan a los cuatro circulos mas pequerios.
Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple]:

Aunque estemos trabajando en 3D, AutoCAD no lo sabe y nos pide una linea. Es igual, pues
seleccionamos la arista que queremos achaflanar de uno de los agujeros. Inmediatamente aparece

Base surface selection... Vemos que a pesar de seleccionar una arista se activa una superficie. Esta
es la superficie base de los chaflanes. Si no esta seleccionada la tapa superior utiliza la opcién Next,
cuando lo esté, selecciona Ok.

Enter surface selection option [Next/OK (current)] <OK>: OK
Specify base surface chamfer distance: 0.8

Specify other surface chamfer distance <0.8000>: 0.8

Select an edge or [Loop]: Vamos seleccionando las aristas de los
circulos para obtener al final...

Vamos a hacer los cuatro agujeros que nos quedan en la parte posterior. En este caso el sistema
utilizado se basara en lineas auxiliares para facilitar la colocacién.

Necesitamos dibujar las lineas de la figura:

Ejercicio: Dibujalas, para ello utiliza las
herramientas: Line, Rotate, Mirror. La idea es
crear una linea horizontal de longitud

adecuada, luego la giramos un cierto angulo
(50° 0 55° seguin sea el caso), para después hacer
una simetria respecto de la horizontal y obtener
la otra linea.

En el punto final de una de las lineas
colocaremos un cilindro.

Primero ponemos el UCS World.

Pagina 15



Tutorial 3D AutoCAD 2000 - Planimetria Asistida

J Cylinder

Specify center point of base or [3P/2P/Ttr/Elliptical]: Punto final de una de ”Q
las lineas. . N

Specify base radius or [Diameter]: 2.4

Specify height or [2Point/Axis endpoint]: 8

Vamos a copiarlo.

S Copy
Select objects: Seleccionamos el cilindro.
Specify base point or displacement [Multiple]: m
Specify base point: Punto final de la linea de referencia.

Specify second point or <use first point as displacement>: Iremos seleccionando los tres puntos
finales de las tres lineas.

Borramos las lineas auxiliares y hacemos la diferencia para obtener los agujeros con el comando
Subtract, quedando...

Ahora nos situamos en uno de los agujeros recién creados y dibujamos un
circulo centrado en él de radio 3.2, obteniendo...

Ejercicio: Copialo en los deméas agujeros y estdmpalos (Imprint) al sblido. Luego
extrusiona las caras creadas hacia adentro una distancia de 2.4 con angulo 0.

El resultado debe ser el de la figura:

Vemos como quedan los nuevos agujeros en la ampliacién.
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Bien, esto se esta acabando, solo nos quedan los redondeos de las esquinas.

Los radios de los empalmes y el orden en que se han de hacer se muestran en la figura:

Vamos a hacer el primer redondeo mostrado en la figura:
(" Fillet

Select first object or [Undo/Polyline/Radius/Trim/Multiple]: Designamos una ///
de las aristas que queremos redondear, por ejemplo la de la figura.

Enter fillet radius <0.0000>: 0.8 h {
Select an edge or [Chain/Radius]: ¢ ‘
Normalmente utilizaremos la opciéon de cadena para que AutoCAD nos seleccione automaticamente

las aristas contiguas a la seleccionada.

Select an edge chain or [Edge/Radius]: Seleccionamos una cualquiera de la cadena obteniendo todo
el conjunto, tal como indica la figura.

Seleccion de toda
la cadena >
o v 3
1 2
\\ =
\
NG Ac)
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Y el resultado...

Ejercicio: Es evidente, no? Acaba los demés redondeos de la misma forma.

Nota sobre los empalmes en sélidos:

e El orden es importante, pues puede ser que si se altera no se pueda crear el empalme. Esto
ocurre por ejemplo si intercambiamos el 5°y el 6° empalme del eje mplo.

e Puede ser que no se creen por ser el radio demasiado grande o demasiado pequerio para la
figura.

e Si eliminamos la cara creada por el empalme (opcién eliminar caras) AutoCAD es capaz las
mayoria de las veces de volver a la situacién original.

Si1 todo ha salido bien hemos creado un sélido complejo como el que pretendiamos.
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